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Introducción 
 

KyPlot es un entorno integrado para el análisis y representación de datos. Mediante 
KyPlot se puede realizar análisis de datos recogidos a modo de hoja de cálculo, usando 
una amplia variedad de métodos estadísticos y matemáticos. También permite representar 
de forma gráfica los propios datos y los resultados de los análisis. 

 

Hoja de cálculo 
 

Se trata de una ventana compatible con hojas de cálculo de Excel, que soporta 
cálculos formulados en las celdas de datos. KyPlot proporciona métodos de computación 
como pueden ser: optimización matemática, análisis espectral, etc. Además, ofrece una 
gran variedad de procedimientos estadísticos incluyendo test tanto paramétricos como no 
paramétricos y análisis multivariados. 
 

Gráficos 
 

Se pueden crear gráficos y completarlos con anotaciones propias. KyPlot permite: 
personalizar cada aspecto de una gráfica, realizar ajustes lineales, no lineales, 
interpolaciones, etc. 

Sobre Kyplot 

Kyplot es un programa de Koichi Yoshioka, de uso libre hasta la versión 2 Beta 15. Por 
este motivo resulta idóneo para que los estudiantes de titulaciones científicas y técnicas se 
familiaricen con el tratamiento de datos inherente al trabajo experimental y con los 
estándares propios del contexto científico. 

 http://www.quantlet.de/scripts/compstat2002_wh/paper/invited/K_yoshioka.pdf 
 

Sobre esta guía 
 
Algunos aspectos básicos de esta guía han sido extraídos de la página Web 
http://www.kyenslab.com/en/support/graph/index.html, mientras la mayor parte, y en 
particular aquellos más específicos del análisis de datos científicos (ajustes de gráficas), 
son originales. 
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Hoja de cálculo 
Importar Datos 
Los datos se pueden importar desde ficheros de texto estructurados en columnas con 
separadores (coma, punto y coma, etc.), al igual que sucede en otros programas análogos.  

Creación de tablas de datos 
Es una forma de entrar los datos experimentales de forma guiada. Cuando se hace uso de 
esta opción (Data>Create Data Table) aparece un diálogo en el que podemos escoger una 
plantilla, de entre las disponibles, para introducir los datos en la hoja de cálculo de forma 
estructurada.  
 

 

 
Los valores que se pueden elegir para la variable X son:  
 

• “Same X”: establece una columna donde se introducirán los datos 
experimentales para la variable X. 

• “Same X, Constant Interval”: igual a la anterior, pero ahora los valores X serán 
rellenados a partir de un valor inicial y el incremento. 

• “XY Pairs”: para agrupar por pares, de forma que hay tantas columnas X como 
series Y. 

Los valores que se pueden elegir para la variable Y son: 
 

•  “Y (Direct Input)”: para que los valores de la variable Y sean exactamente los 
introducidos. 

• “Y (Indirect Input)”: para que los valores de la variable Y sean exactamente los 
introducidos si se ha introducido un número, en otro caso no tiene efecto. 

• “Cumulative”: los valores se van acumulando, siempre que el valor introducido 
sea número. 

• “Proportion”: El valor resultado es proporción del total de valores. 
• “% Proportion”: igual al anterior pero en tanto por cien. 
• “Mean”: el valor resultado es la media de una serie de valores. 
• “Mean, Std error of Mean”: igual a anterior, pero el resultado incluye el error 

estándar de la media. 
• “Mean, Standard Deviation”: los valores Y son la media y la desviación 

estándar de los valores  obtenidos experimentalmente. 
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• “Mean, Max-Mean, Mean-Min” 
• “Mean, Max, Min” 

 
Una vez elegido el tipo de dato para Y, se especifica el número de series que se 

desean para Y así como cuantas repeticiones por serie se requieren. 
 
La nueva tabla de datos se puede generar en una hoja nueva (Output-New Spread) o 

en la actual (Output-Current Sheet) a partir de una determinada celda (Starting Cell). 
 
Una vez realizados estos pasos, sólo nos queda rellenar los datos tanto para X como 

para las series Y. 
 

 

Tipos de Datos y formatos 
Seleccionar Format >Cell Object y 
aparecerá una ventana en la que 
se puede elegir el tipo de dato de 
cada columna y/o grupos de 
celdas (que se habrán 
seleccionado previamente). 
Es posible elegir el tipo de 
número y el número de cifras 
decimales que se desean 
visualizar (ver “Formato de los 
números de los ejes”, p. 12). 
Al importar ficheros es posible ver 
todos los decimales que aparecen 
en las celdas seleccionando All > 
General 

 

 

Generación de valores equiespaciados 
En algunos casos, es necesario generar una serie de datos equiespaciados (normalmente 
la coordenada x, como el tiempo transcurrido a la hora de medir o el voltaje aplicado…).  
 
En vez de hacerlo a mano, Kyplot tiene una función para generar estos datos. Para 
acceder, en el menú “Edit”, selecciona “Fill” y “Fill Range” (ver figura siguiente): 

 
- En “X Series type”, puedes seleccionar que la serie sea lineal o cuadrática. Si 

deseamos valores equiespaciados, será lineal. 
- En “Menu” selecciona “Create X series”. “Calculate Formula F(X) (X: selected 

range)” sirve para, seleccionados unos valores como X, calcular la función dada en “Input 
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Formula” de esas X. La tercera opción combina las dos primeras, crea la serie de datos y 
las usa como X para calcular la F(X). 

- “En X Series Range” hay varias opciones para crear la serie. “Fill the selected 
Range” rellenará todas las celdas que hayas seleccionado con la serie. “Fill to the End 
Value” creará la serie hasta que llegue al “End Value” que le indiques. “Fill the Specified 
Range” creará el número de puntos que le indiques. En todos los casos has de indicar el 
número inicial de la serie en “Start Value” y la diferencia entre cada número de la serie en 
“Step Value”. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 

 

Operaciones con celdas 
Para realizar operaciones con celdas se puede proceder al “estilo Excel”, que es 

escribiendo directamente la fórmula en una celda haciendo referencia a otras celdas y 
arrastrando esta fórmula a otras celdas; o bien al “estilo Kaleida”, que es indicando 
operaciones entre grupos de celdas. Ejemplo: 
 

Tenemos los siguientes datos, 

 
 

Y queremos dividir los datos de la columna B entre los de la columna A, quedando el 
resultado en la columna D. 
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• “Estilo Excel”, escribimos en la celda D1 “=B1/A1”, seleccionamos la celda D1 (que ya 
debe mostrar el resultado de la operación), pinchamos en el cuadradito negro de la 
esquina inferior derecha de la selección y arrastramos hacia abajo hasta la celda D7. 
Esto arrastrará la fórmula a todas las celdas hasta la D7 cambiando el número de la fila 
por el que corresponda (es decir, en D2 quedará “=B2/A2”, en D3 “=B3/A3”…). 

 

 
 

Nota: Para evitar que al arrastrar la fórmula, cambie la fila o columna de alguna celda 
de la fórmula, colocar en la fórmula un “$” delante de la fila y/o la columna que no debe 
variarse al arrastrar la fórmula . Ejemplo: para multiplicar la columna de datos de antes el 
valor de la celda F3, si ponemos en D1 “=B1*F3” y arrastramos la fórmula hacia abajo, en 
la celda D2 pondrá “=B2*F4”, en la D3 “=B3*F5”…; en cambio, si escribimos en D1 
“=B1*F$3”, al arrastrar, en D2 quedará “=B2*F$3”, en D3 “=B3*F$3”…, como queríamos. 

 
• “Estilo Kaleida”: en el menú “Data”, opción “Transform…”, se pueden realizar 

operaciones sobre un grupo de datos (has de seleccionar primero el grupo de celdas 
que contienen los datos). Las celdas de salida se le indican al programa en la opción 
“Output Starting Cell”, mientras que la operación a realizar se encuentra en 
“Transform”, el “Output as” te indica si el resultado son directamente números, o bien 
una fórmula (cuyo resultado variará instantáneamente si cambias los datos). 
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Para realizar operaciones entre distintos grupos de datos, en el menú “Math” 
selecciona “Matriz/Vector Operation…”, la ventana es análoga a la de “Transform…” 
salvo que le puedes indicar los grupos de datos en “Input Matrix/Vector A” y “Input 
Matrix/Vector B”. 
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Creación de gráficas 
 

Para crear una gráfica hay que seleccionar en la hoja de cálculo los datos que se 
desea representar.  
 
Luego, a través de la opción de menú (Graph>Create Graph) u opción equivalente en la 
barra de herramientas, se abre el cuadro de diálogo asociado a la creación de una gráfica. 

En el diálogo que aparece elegimos qué tipo de dato es X (X Data Type) e indicamos 
también qué tipo de dato es Y (Y Data Type). Ambos tipos de datos normalmente deben 
coincidir con los dados al crear la tabla de datos. Además podemos representar el error 
estándar (Y&Error/bubble), los errores máximo y mínimo (Y&+-errors) y los valores máximo 
y mínimo (Y, Hi & Lo). En la zona inferior del cuadro de diálogo vemos los datos que el 
programa interpreta como X, Y, etc. Por supuesto, los valores que contienen estas celdas 
deben coincidir con las columnas correspondientes de la selección realizada previamente. 

Por ejemplo X(Col) es la columna B de la tabla de datos, Y es la columna C para “Control – 
Serie 1” y es la columna E para “Inhibitor – Serie 2”. 

 
El cuadro de diálogo permite también añadir nuevas series, borrar series existentes, 

intercambiar X por Y, invertir el orden de las series, etc. Una vez decidido lo que queremos 
representar, pulsamos “OK”. Aparece otro diálogo donde especificamos el tipo de gráfica 
(gráfica de líneas, barras, radar, etc.), y se configuran sus opciones (los textos de la 
gráfica, el título de la gráfica, el título del eje X, el título del eje Y), con la posibilidad de 
seleccionar como títulos los ubicados en la tabla de datos activando la opción “Sheet” y 
estableciendo la celda adecuada. Por último este diálogo permite establecer algunas 
opciones para la gráfica como pueden ser:  

 
- sombras en datos y ejes 
- recorte de datos al área dibujada (Clip data to plot area) 
- actualización de la gráfica cuando algún dato cambie 
- orden de los símbolos utilizados para representar datos con respecto a los 

componentes de la gráfica (ejes y líneas de rejilla). 
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Una vez realizados los 

ajustes deseados pulsamos otra 
vez “OK” para obtener la gráfica. 
 
 
 
 
 
 
 
 
 

 

Formato de gráficas 
Presentar múltiples gráficos en una misma hoja 
Lo primero que pregunta el programa a la hora de crear un gráfico es si se desea 

crear el gráfico en una hoja nueva (“Figure”) o en una ya creada. Esta última opción te 
permite presentar distintos gráficos simultáneamente en la misma hoja, sólo has de 
seleccionar el archivo donde quieras añadir el nuevo gráfico. 

 

 
 
 



Guía de Kyplot    Facultat de Física- Universitat de València 

10 

Formato de ejes 
 
En la página de figuras, 
selecciona una gráfica haciendo 
clic en su área o pulsando la 
tecla “TABULADOR”.  

 
Una vez realizada esta 

selección utiliza la opción de 
menú Graph>X Axis>Set o haz 
doble clic cerca del eje X en la 
gráfica o selecciona el eje X de 
la gráfica y pulse el botón 
“Propiedades” en la barra de 
herramientas. De esta forma 
aparecerá el diálogo de 
configuración del eje X de la 
gráfica. 
 

Mediante este diálogo, ajusta los ejes X e Y a sus necesidades, cambiando la escala 
(en el ejemplo escala logarítmica) y su rango (en el ejemplo 0.0007 -- 0.7), el formato de 
línea, etc. En la pestaña “Minor Tick Mark”, figura siguiente, indica el tipo de marca menor 
(en nuestro ejemplo Log: 3, 30…), cuantas divisiones deben haber por cada marca mayor 
(2 en el ejemplo) y al lado configuramos su tipo de línea y si queremos que salga del eje 
hacia fuera (Out) o entre hacia dentro de la gráfica (In) o ambos (marcando tanto In como 
Out). Los “Minor Tick Marks” son los puntos del eje X/Y que no tienen asociado un valor 
visible. Por el contrario los “Major Tick Marks” son los puntos del eje X/Y que tienen 
asociado un valor visible en la gráfica. 

 
 
 
 

Del mismo modo que 
hemos configurado la pestaña 
“Minor tick Mark”, se configura la 
pestaña “Major Tick Marks”. En 
este caso seleccionamos (en 
Select) “Single” y añadimos 
hasta disponer de 4 puntos en el 
eje X. Dando al punto 4 del eje X 
el valor 0.5 (en “Major Tick 
Position (Single)) 

 
 
 

 
 

Una vez realizados los ajustes necesarios pulsa “OK” para que tengan efecto en la gráfica 
seleccionada. 



Guía de Kyplot    Facultat de Física- Universitat de València 

11 

 

 

 

 

 

 

 

Introducir ejes adicionales 
Selecciona un eje, click derecho y “Set properties”. En la esquina superior izquierda 

aparecerá marcado “Left/Bottom Axis” (según hayas seleccionado el eje izquierdo o el 
inferior), pulsando sobre “Right/Top Axis” accederás a las propiedades del eje 
derecho/superior, y marcando la opción de “Show Right/Top Axis” aparecerá. La 
configuración es idéntica a la de los ejes izquierdo o inferior, y puedes indicarle que te 
aplique la misma configuración marcando “Right/Top Styles = Left/Bottom Styles”. 

 
 

 
 

Cambiar el intervalo de marcas grandes (números) en los ejes 
Selecciona un eje, click derecho y “Set properties”. Pincha en la pestaña “Mayor Tick 

Marks”, marca “Custom, All” y en “Interval” escribe el intervalo deseado entre marcas 
grandes del eje (y por lo tanto entre números). 
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Cambiar el número de marcas pequeñas entre las grandes 
Selecciona un eje, click derecho y “Set properties”. Pincha en la pestaña “Minor Tick 

Marks”. Cambia el valor de “Divisions  per Mayor Tick”. Si lo que quieres es que no 
aparezcan, deselecciona tanto  “In” como “Out” en “Direction” (en la misma pestaña).  

 

 
 

Formato de los números de los ejes 
Selecciona un eje, click derecho y “Set properties”. Pulsa sobre el botón “Labels”. 
Para cambiar el tamaño o la fuente, en la pestaña “Format” pulsa “Font” (abajo a la 

izquierda). 
Para cambiar la presentación de los números (decimales, exponentes, etc), en la 

pestaña “Format”, pulsa “Set Format” y “Custom”: 
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• Para que aparezcan n decimales, escribe un “0.” seguido de n “0”. Ej: 5 cifras 
decimales se escribiría como “0.00000”. 

• Para que además aparezcan exponenciales, simplemente añade “E+” seguido 
de tantos “0” como cifras quieres que aparezcan en el exponente. Ej: 
queremos que aparezca con un decimal y dos cifras en el exponente, 
“0.0E+00”, el número 27 se mostraría como “2,7E+01”. 

• Si queremos que aparezcan más cifras significativas a la izquierda de la coma, 
tendremos que añadir “#” a la izquierda del “0.”. Ej: “#0.0E+0” mostraría al 
número 27 como “27,0E+0”. 

 

 
 

 

 

Formato de las líneas de la rejilla 
 

Selecciona una gráfica y abre el diálogo “PlotArea/Grids” a través de la opción de 
menú Graph>Plot Area/Grids. En este ejemplo añadiremos una línea de rejilla horizontal 
sobre el nivel de control máximo (9.85). Para ello lo primero que haremos, será modificar la 
configuración del eje Y para añadir un nuevo punto (el 12) y le daremos el valor 9.85 (ver 
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cómo hacer esto en el apartado anterior). Una vez realizado, abrimos el diálogo 
“PlotArea/Grids” como se ha mencionado y en la pestaña “Major Grids” seleccionamos la 
opción “Show Y (Horizontal) Major Grids”. Luego en “Y (Horizontal) Major Grids” 
seleccionamos “all” y establecemos su tipo a “no line”. De esta forma, evitamos que se vea 
una línea por cada marca major del eje Y.  
 

 
 

Luego seleccionamos “single”, escogemos el punto 12 (cuyo valor debe ser 9.85) y 
especificamos el tipo de línea como “Solid/Dotted”. 

 

 
 

 
Por último pulsamos “Apply” o “OK” para que los cambios tengan efecto. 
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Etiquetar ejes 
Una vez seleccionada una gráfica, utiliza la opción de menú Graph>X (o Y) 

Axis>Labels o haz doble clic en el eje X o Y mientras mantienes pulsada la tecla 
control. Aparecerá un cuadro de diálogo como el siguiente: 
 

 
 

La unidad de medida 
puede ser cambiada. En la 
pestaña “Location” selecciona 
la opción “Custom” y pon el 
valor inicial y el incremento. 
También puedes añadir una 
etiqueta al valor i-esimo de una 
muestra de datos, por ejemplo, 
escribir “Maximo: 9.85” sobre el 
valor número 12 representado 
sobre el eje Y (en la pestaña 
“Location” podrás definir el 
desplazamiento de esa etiqueta 
respecto del eje X e Y). 

 
 
 
Todo ello nos dará como resultado la siguiente gráfica: 
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Editar títulos 
 

Es posible modificar los títulos de los ejes X e Y de cualquier gráfica. Para ello, haz 
doble clic sobre el título actual. Un editor de texto aparecerá. Modifica el texto a su gusto y 
ten en cuenta la posibilidad de escribir símbolos griegos, etc. 
 

 
 

Girar objetos (como un título de eje) 
 

Selecciona el objeto que deseas girar, pincha en la pestaña Transform (es la última 
de las pestañas que aparecen a la izquierda del todo), y pincha en los símbolos de giro, o 
bien pincha en el menú “Arrange”, selecciona “Rotate/Reflect” y el giro deseado. 
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Símbolos para los datos 
 

Selecciona la gráfica y pulsa sobre la opción de menú Graph>Data>Symbols. En el 
diálogo que aparece selecciona “All” en “Select Symbols”. Luego puedes elegir el tipo de 
símbolo deseado para la serie de datos. 

 

 
 
Una vez realizado esto, selecciona la opción “Series” en “Select Symbols” y configura 

las propiedades del símbolo para dicha serie. Repite el proceso para el resto de series de 
datos (si las hay). 
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Formato de leyendas 
 

Selecciona la gráfica y 
accede a la opción de menú 
Graph>Leyend. En el cuadro de 
diálogo que aparece, realiza los 
ajustes deseados para las 
leyendas que se mostrarán en la 
gráfica. Por último, pulsa “OK”. 

 
 
 
 
 
 
 
 
 

Guardar el formato como predeterminado 
 

Es posible guardar el formato de un grupo de elementos  (ejes, títulos, rejilla, etc) del 
gráfico como predeterminado, así el programa utilizará esta configuración para ese mismo 
elemento de todos los futuros gráficos que se vayan a crear. Para guardar la configuración 
como predeterminada, pincha en el botón “Save” de abajo a la derecha de la ventana de 
configuración del elemento en cuestión, y pincha en “Aceptar” en el menú que aparece 
pidiendo confirmación. 
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Copiar gráficos a Office 
En algunas versiones de Windows y/o Office el copiado habitual de los gráficos es 
defectuoso (se recorta parte de la imagen). En caso de que esto ocurra, lo que hay que 
hacer es exportar la gráfica. Para ello, en Kyplot, seleccionar con el ratón las gráficas que 
se desean copiar (es preferible hacerlo englobando con el rectángulo del ratón toda la 
supercicie que se quiere copiar), en el menú “File”, seleccionar “Export...” y  escribir el 
nombre de la imagen donde se guardará la gráfica, en la siguiente ventana que aparece 
(“Export Options”) marcad la opción “Use KyPlot’s proper routine” y pinchad en OK. Si se 
encuentra algún problema a la hora de exportar las figuras, en la ventana “Export as File” 
elegir otro formato diferente a “Windows Metafile (*.wmf)”. Por ejemplo “Enhanced Metafile 
(*.emf)”. Este formato no suele presentar problemas. 

 
Ahora, para llevarla a cualquier programa de Office, hay que importarla, esto se hace 

en el menú “Insertar”, seleccionar “Imagen” y después “Desde archivo...”. 
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Ajuste de datos experimentales 
 

Para ajustar una serie de puntos a una función, selecciona la gráfica de la que 
quieras realizar el ajuste, pincha en el menú “Graph” y selecciona “Fit”. 

Selecciona la función a la que deseas ajustar en “Formula”. Aparecerá una breve 
descripción de la función en el cuadro blanco de la derecha. Pincha en “Apply Fit” y Kyplot 
calculará y dibujará el ajuste elegido.  
 

 
 

Se pueden hacer varios ajustes sobre la misma gráfica. Si deseas crear uno nuevo, 
pincha en “New Fit”. Para cambiar entre un ajuste y otro, cambiar el número de “No.:”. Si 
deseas eliminar un ajuste, selecciona el número correspondiente y pincha en “Delete Fit”. 
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Hoja de resultados estadísticos 
 

Para obtener los resultados del ajuste (valores, errores, coeficiente de correlación), 
dentro de la ventana de ajuste, pincha en “Statistics”: 
 

 
 

Aparecerá una ventana como la que sigue con toda la información: 
 

 

Valores de los parámetros 
Errores de los parámetros 

R2
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Funciones de interés y  su archivo en Kyplot 
Exponenciales 
Y=A1*(1-EXP(-A2*X)) Expass1.fun 
Y=A1*(1-EXP(-A2*(X-A3)))+A4 Expass1o.fun 
Y=A1*EXP(-A2*X) Expdec1.fun 
Y=A1*EXP(-A2*(X-A3))+A4 Expdec1o.fun 
Y=A1*EXP(A2*X) Expgro1.fun 
Y=A1*EXP(A2*(X-A3))+A4 Expgro1o.fun 
Y=EXP(A1+A2*X+A3*X^2) ExpQuad.fun 
Y=A1*10^(-A2*X) P10dec1.fun 
Y=A1*10^(A2*X) P10gro1.fun 
Rectas 
Y=A1*X Linereg0.fun 
Y=A1+A2*X Linereg.fun 
Polinomios 
Y=A1+A2*X+A3*X^2 Quadreg.fun 
Y=A1*X+A2*X^2 Quadreg0.fun 
Y=A1+A2*X+A3*X^2+A4^3+A5^4+... Multiline.fun 
Gausianas 
Y=EXP(-(((X-A1)/A2)^2)/2) 
/(SQRT(2*PI)*A2) 

Normald.fun (Gausiana de área unidad) 

Y=A3*EXP(-(((X-A1)/A2)^2)/2) 
/(SQRT(2*PI)*A2) 

Normalda.fun (Gausiana de área A3) 

 

Introducir nuevas funciones 
Para ajustar a una función nueva, en la ventana de ajustes, pulsa en “New”. 

Selecciona el número de parámetros a ajustar en “# Parameters” y escribe la función a 
ajustar en la primera celda de la columna “Formula”. 
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Puedes guardar la función creada pulsando en “Save…”, estando así disponible en 

tus próximos ajustes. 
 

 
. 

Parámetros iniciales 
El programa tiene la opción de introducir los parámetros iniciales que utilizará para 

realizar el ajuste, a veces esto será absolutamente necesario para que el programa pueda 
realizar con éxito el ajuste. 

Estos parámetros iniciales deben ser lo más cercanos posibles a los valores que 
mejor ajusten la curva, por lo que lo ideal es tener una estimación o conocer el orden de 
magnitud. 

Por defecto, el programa utiliza el 1 como parámetro inicial para todos los valores, 
pueden cambiarse en la columna A-Value de la ventana de ajustes.  
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Ligaduras en el ajuste 
 

Kyplot permite que definas ligaduras entre los parámetros del ajuste. Selecciona el 
número de igualdades y desigualdades que deseas fijar en “# Inequalities” y “# Equalities”. 
Pulsa en “Edit” y escribe las ligaduras en “Eq.=0” o “Ineq.>=0” según corresponda, 
teniendo en cuenta que la primera celda de cada columna corresponde a la primera 
igualdad o desigualdad y así sucesivamente. 
 

 
 
Dos de los casos más comunes a la hora de realizar ligaduras son exigir que todos 

los parámetros del ajuste sean positivos, o que la suma de todos los parámetros sea la 
unidad. Existen dos botones que realizan directamente estas ligaduras, el “All>=1”, y el 
“Sum=1”. 
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 En el caso del “All>=1”, todos los parámetros se colocan en la columna de 
inecuaciones, indicando que todos deben ser positivos.  
 

 
 
En el caso del  “Sum=1” aparece una única ecuación que indica que la suma de 

todos los parámetros menos la unidad es igual a cero. 
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Ajuste de varios conjuntos de datos en la misma gráfica 
 

Para ajustar dos o más conjuntos de datos representados en la misma gráfica, tan 
sólo has de preocuparte de seleccionar la serie de datos adecuada para cada ajuste. Para 
cambiar la serie de datos sobre la que realizas el ajuste, cambia el número en el apartado 
“Series” de la ventana de ajustes. 
 

 
 

Representar funciones analíticas sobre un conjunto de datos 
 

Para representar una función analítica, primero pincha sobre el gráfico en el que 
quieras pintar la función, y luego pincha en “Fit”, como si fueras a realizar un ajuste. En la 
opción “Menu” selecciona “Function Fit”. 

Se puede pintar en forma Y=F(X) o bien en forma paramétrica X=F(T), Y=G(T). En 
ambos casos, el límite inferior y superior rango en X (o en T) deben escribirse en la 
primera y segunda celda d la columna “X Range” (o “T Range”) respectivamente.  

En el caso Y=F(X), F(X) debe escribirse en la primera celda de la columna “F(X)”; en 
el caso paramétrico, F(T) y G(T) se escriben en la primera y segunda celdas de la columna 
“F(T)/G(T)” respectivamente. Finalmente, pinchar en “Apply Fit”. Se puede configurar el 
formato de la representación pinchando en el botón “Fit Patterns”. 
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Cambiar el rango de la curva del ajuste 
 

Por defecto, la curva del ajuste va desde el primer punto experimental hasta el último, 
pero es posible cambiarlo. Para hacerlo, en la ventana del ajuste, pincha en “Range”, 
desmarca la opción “Auto”, y establece los valores inferior y superior del rango deseado. 
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Ejemplo de ajustes en un mismo gráfico 
 

Disponemos de dos series de datos con un mismo X (la columna A) para representar 
y ajustar en la misma gráfica. Seleccionamos los datos,  pinchamos en “Create Graph” y 
seleccionamos las opciones para crear nuestro gráfico: 

 

 
Vemos que se trata de una exponencial decreciente y de una función sinusoidal. 

Comenzaremos con el ajuste de la exponencial (columna B, serie de datos 1). 
Pinchamos en “Fit”, y nos aseguramos de que se trata de la exponencial (podemos 
comprobarlo con los datos que aparecen en la columna Y1 o por que está seleccionada la 
serie 1). Buscamos la exponencial adecuada (Expdec1.fun, nótese que tiene una 
inecuación que exige que el parámetro A2 sea siempre positivo, obligando a que la 
exponencial sea siempre negativa)  y aplicamos el ajuste.  
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El ajuste se realiza correctamente: 

 
Ahora realizaremos el ajuste de la función sinusoidal. Antes de nada, pincharemos en 

“New Fit” para no sobreescribir el ajuste de la exponencial. Ahora seleccionamos la serie 
de datos 2 y creamos un nuevo ajuste a una función F(X) = A1*COS(A2*X+A3). 
Exigiremos que A1 y A2 sean positivos a través de inecuaciones. 
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El ajuste no ha tenido éxito: 

 

 
 

Tendremos que modificar los valores iniciales del ajuste, podemos estimar fácilmente 
la amplitud de la función sinusoidal, aproximadamente debe valer A1=5. Repetimos el 
ajuste eliminando el parámetro A1 para obtener así el valor aproximado de los otros dos. 
La ecuación a ajustar quedaría: F(X)= 5*COS(A1*X+A2). Debemos eliminar la inecuación 
sobrante y reajustar el número de parámetros. 

 

 
 

El ajuste vuelve a fallar: 
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Vemos que la frecuencia de la sinusoide (ahora A1) resultante del ajuste es mayor 
que la de los datos, por lo que probemos ahora con la mitad (en vez de 1 que es lo que 
sale del ajuste fallido, pondremos 0.5 en los valores iniciales): 
 

 
 

Por fin se ajusta a nuestros datos, ahora volveremos a dejar libre el parámetro de la 
amplitud, pero usaremos los valores iniciales para realizar el ajuste. Es decir, ajustaremos 
a la función A1*COS(A2*X+A3) con valores iniciales A1=5, A2= 0.62 y A3=0.24: 
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Ajustándose con éxito y dándonos los valores más próximos de nuestros parámetros: 
 
 

 
  
 
 
 
 
 
 

 


